September 2024 Forecast Guidelines:
What’s new for the September 2024 forecast:
Summary of Financial Position
As part of the 2024 September forecast, we are asking units to complete a brief Summary of Financial Position explanation included on the ‘Summary’ tab of the Forecast Template. This will be a high-level explanation of your forecasted in-year position by identifying key variances. This is required to be completed at the BPU level as indicated in the Budget Liaison Contact List. See Appendix F for details on unit requirements.
Variance Explanations
Units will no longer be required to provide detailed variance analysis on the ‘Sep Forecast’ tab of the Forecast Template. Units may choose to continue to provide variance explanations using the notes column V to support their internal planning and continuity. See Appendix B section G for additional details.
Self-funded Compensation Contribution (66012)
For 24/25 units were given self-funded inflation contributions that have been recorded in object 66012. Units are required, if able to articulate, their plan to address this through budget adjustments for their units balance in 66012 in the appropriate FRS object codes on the 'Sep Forecast' tab. If you are not able to articulate this and therefore there is a remaining balance in 66012 on the Summary tab, please briefly identify your plan to address this in your Summary of Financial Position explanation. This should include FRS category where possible and timeline for implementation. See appendix B and Appendix F.
Unit 24/25 Planning Parameters
· Carryforward spending is not approved, except in special previously approved circumstances
· Self –funded compensation contributions should be resolved in-year and at the earliest possible opportunity. If your unit has a balance in 66012 please identify your plan to address this within your forecast. 
· Given the timing of the September forecast, some employee groups may remain unratified. Please do not include any assumptions around inflation or other compensation/ monetary outcomes for these employee groups. These planning parameters are also included for completeness in Appendix B.
Please review your unit forecast submission to ensure the information is correctly consolidated, calculated and the automatically populated columns reconcile to FRS with any additional adjustments clearly noted. The budget team has created a unit checklist that should be reviewed prior to submissions.
Please use the following guidelines (Appendix A-F) to prepare a unit forecast of year end results for the 2024/2025 fiscal year.
Appendix A: Forecast Reporting Guidelines
Appendix B: Instructions for Forecast Templates
Appendix C: Instructions for Forecast Data Download
Appendix D: Combine Template Forecast Instructions
Appendix E: Vacancy Savings Template
Appendix F:  Summary of Financial Position
To complete the required forecast, you need to download the ‘September 2024 Forecast Template Package’ found on the Institutional Research and Planning website.
Please follow the step-by-step instructions in Appendix B – Instructions for Forecast Template, and Appendix E – Vacancy Savings Template and general instructions for Appendix F – Summary of Financial Position.
Please prepare a ‘2425 September Forecast’ template for each of your areas of responsibility separately by fund for the General Operating funds (100 - General Operating; 102 - OVC Special Grant; 104 - Diploma Education; 105 – OVC HSC). Please refer to the Budget Liaison Contact List for details on the budget units to report on by fund. The Dean’s Office or Directorate Office is responsible for accumulating, consolidating, reviewing, and approving the detailed forecasts for their respective college or directorate, as outlined in the contact list.
[bookmark: _Hlk110848153]The Budget Team compiles all the college/divisional forecasts and budget plan information into the University summary and is presented to the Board of Governors. To be able to do this accurately, we need consistent submissions from all units.  Please ensure that your forecast is in the template provided.
The FRS system functionality allows the direct download of FRS report data into an Excel spreadsheet. Detailed instructions are provided in the Appendices below.
PLEASE E-MAIL YOUR SEPTEMBER 2024 FORECAST TEMPLATE PACKAGE, INCLUDING YOUR COMPLETED, FORECAST, VACANCY SAVINGS TEMPLATE AND SUMMARY OF FINANCIAL POSITION TO:
	Budget.innovation@uoguelph.ca


 SUBMISSION DEADLINE FORECAST: September 9, 2024
September 2024 Forecast Preparation Support:
For assistance in preparing your forecast, please contact your Budget team liaison member, as outlined on the Budget Liaison Contact List for each budget unit.


[bookmark: AppA]Appendix A: Forecast Reporting Guidelines
A.  Purpose of Forecast:
There are two in-year forecasts that need to be completed for each budget unit in this fiscal year.
The forecast due on September 9, 2024 estimates units’ total spending for the 2024/2025 fiscal year, based on one semester of actual results. The January forecast is to update the above in-year forecast based on an additional semester of actual results. Both forecasts will be presented to the Board of Governors. 
The fundamentals for building your forecast and explaining variances between actual and budgeted results should be part of your normal financial management routines. This guideline provides general instructions for preparing a forecast in a consistent format for summary purposes. Explanations of key cost and revenue assumptions are an integral part of every forecast submission.
The Budget Team compiles all the college/divisional forecasts into the University summary which is presented to the Board of Governors.
B.  Assumptions:
Each budget unit will have different methods and capabilities of completing this forecast.  Some have ongoing forecasting procedures; others have periodic forecasting efforts depending upon both the time of year and status of their budget.  This requirement to complete a forecast should be an extension of those procedures and not in addition to or separate from them.  Methods of forecasting expenditures and revenues may include using historical trends, using current commitments for personnel costs, and using planned expenditures not yet recorded in FRS.  The segregation of special purpose or special project funds from the rest of operating funds may be helpful in compiling this information.  Please include notes (column V) on the forecast template to outline your assumptions, variances (at your discretion), or any other relevant information.
C.  Degree of Accuracy:
We want to encourage units to be forecasting as accurately as possible given that this information will be used to help advise University leadership on managing financial pressures. The acceptable target for accuracy is 2% of your overall budget (excluding carryforward) in 2024/25.  
By its nature, any forecast contains a certain element of estimation and intelligent guesswork.  This exercise is no exception. You will not be able to forecast exactly. However, your information is the basis of the consolidated University forecast, and accuracy is important. Please ensure you list any assumptions associated with major revenue and expense forecasts for the year.


[bookmark: AppB]Appendix B: Instructions for Forecast Template
The following appendix provides instructions on how to complete the Forecast Template, and a detailed explanation of the columns within the “Sep Forecast” tab. For instructions on filling out the “Vacancy Savings” tab, please refer to Appendix E.
A. Instructions on Completing Forecast Template
Step 1: Download financial data into the following three data tabs:
· “FRS 2122-2324 Actual Download”
· “FRS 2425 Actual Download”
· “FRS 2425 Budget Download”
Refer to the respective tabs for instructions on how to pull data from FRS, as well as Appendix C for additional FRS data support.
Step 2: Within the “Sep Forecast” tab, add in your units Base and/or One-time budget adjustments into columns F & H. Please refer to Section B for the definition of both ‘Base Adjustment’ and ‘One-time Adjustment’.
Step 3: Within the “Sep Forecast” tab, add the Additional Spend into Column Q. Please refer to Appendix B Section B(e) for the definition of ‘Additional Spend’. Additional spend should be recorded at the type level (grouping level 2), however, you may complete this at the object level if desired (grouping level 3).
B. Explanation of the “Sep Forecast” Tab
The templates this year are based on the September 2023 Forecast Templates and have not changed materially. Below we will outline the various columns in the “Sep Forecast” tab of the template.
Below is an example of the “Sep Forecast” tab, Columns A to T. 
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a. Column C contains the most common object codes. To determine if there are object codes missing from your template, please look at column I in the FRS download tabs. If an object code is missing, it will be highlighted in red in this column. If this happens, please send the template to your budget liaison and they will add the missing object codes and send the updated template back to you.
b. Column B contains a filter to help with the usability of the template. This will allow you to filter your view to only the object codes that contain data either in the budget, actuals or added by the user in a fillable field. To use this feature please click on and select the ‘Y’ in the filter drop down menu
c. Column C also contains the object categories, which is consistent with how the budget plan document reports to the Board of Governors. There are three major categories: Revenues, Expenses and Transfers. Revenue categories include tuition, grants, student fees, sales of goods and services, Guelph Humber, and other. Expenses include salaries, benefits, scholarships and bursaries, utilities, operating, Internal Recoveries/Changes & Transfers and carryforward for budget only. The last section is Transfers. Transfers are from three main streams: OMAFRA, Ancillary and Heritage. These major cost and revenue object categories are further broken down by expense or revenue type. Note: for all categories, at a minimum, units should be forecasting at the type level (excel template grouping level 2) but are able to forecast at the object level if desired. Note: For ‘Salaries’, entries in “Base Adjustment”, “One-time Adjustment” and “Additional Spend” must be completed at the object code level to ensure accurate calculation of benefits on object 62306 from in the Salary tab. This is the only section that shows the objects within the type level at grouping level 2. To see a full list of object codes for each section, please expand all rows in the excel template.
d. Columns D, E, K, L, M, O, & P (columns highlighted in green) will be populated automatically, from the FRS excel downloads. For completing the FRS downloads, please follow step-by-step instructions in Appendix C. 
· Budget (Base) and Budget (One-time) represents your 2024/2025 budget. 
· Actuals 2021/2022, 2022/2023 and 2023/2024 represent the total actual revenues and expense incurred in those years.
· YTD Spend presents the actual expenses and revenues currently recorded in FRS for the 24/25 fiscal year. Please note that the forecast due on September 9 is based on July YTD results and forecasting August 2024 – April 2025.
· Commitments represent the committed payroll and general expenses. The commitments in payroll object codes are estimates of costs for salary and benefits for all regular full-time employees to April 30, 2025 and many temporary appointments to the earlier of either the end of their current appointment or April 30, 2025. Non personnel expenses are committed amounts for un-received goods from open Purchase Orders to April 30, 2025. Please note that you should review all commitments in detail to determine the validity of including them in your forecast. To correct commitments for purposes of the forecast please adjust the ‘Additional Spend’ column and include a note explaining the adjustment. You may encounter the occasional negative commitment amount in your FRS reports.  These amounts are errors that may occur for various reasons against open PO’s in the Oracle system.  Negative commitment amounts result in an overstatement of the remaining balance in the account.  Your forecast should not include any negative commitment amounts (excluding corrections made that may be negative). Please review the Procurement Services information web page on De-Commitment to have unneeded commitments removed.
e. Columns F, H, Q, and V (columns highlighted in yellow) are input or fillable fields, which are not protected. These are the fields you are requested to use for unit forecast submissions.  
· Columns titled “Base Adjustment” and “One-time Adjustment” are to be used if the unit has a budget adjustment that is expected but has not yet been recorded in FRS at the time of the budget data download (utilized if necessary).
· The column titled `Additional Spend' is the column you are requested to input estimated expenses and revenues (up to April 30, 2025) which have not yet been recorded in FRS for 2024/2025. If your department has any commitment or actuals adjustments, please reflect these adjustments in this column as well. 
Please note that when filling out your forecast in these fields you can either fill out at the object level or at the type level (grouping level 2), not both. The exception to this is in salaries as each object code in salaries needs to be forecasted at the object level to get the appropriate benefit rate. If you have values in both the object and the type level the summation formula at the type level will, by default, sum the object codes. For example, the below Figure 1A has a total of 7 in Column P at the type level (grouping level 2 total on Memberships and Training) and is pulling based on information provided at the object level and ignores the amount provided on the total for Memberships and Training. In Figure 1B, if you place data at the type level total and nothing at the object level the formula will pull in the total of $200 as the Memberships and Training total.
Figure 1A
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Figure 1B
[image: A picture containing text

Description automatically generated]
For any unit using formulas to bring in information from another spreadsheet, simply drag down your formula in any fillable yellow coloured column. Please note: the benefits will only calculate in the output columns not the input columns due to the drag and drop functionality. If you are pulling from an external file, please copy and paste values, so when reviewing the template there are no reference errors.  The three column headers in Yellow, Base Adjustment, One-time adjustment, and Additional spend are the columns in the main portion of the template that units are requested to provide input. 
f. Columns G, I, J, R, S, & T (columns highlighted in blue) are output or non-fillable fields, which are protected and contain formulas that pull information from the yellow or fillable fields. 
g. Column Vis where notes should be included describing assumptions made and explaining budget adjustments related to self-funded compensation contribution (66012) solutions in 24/25 or budget adjustments that change a unit’s net budget position.  Units are not required to complete this notes field for variance explanations (which will be completed in the Summary of Financial Position) but may choose to do so to support their internal planning and continuity. Units should also be prepared to speak about their unit activities and plans in greater detail and so may benefit from a more detailed variance analysis at this level. 
General Forecast Instructions
Below are some general instructions for the 2024/2025 forecast procedure:
1. As mentioned in the Overview you will need to create a separate forecast report for each sub-fund in General Operating (fund #100,102,104,105) as part of your September 2024 Forecast Package you create for each sub-fund in General Operating. 
2. Units are welcome to complete a Forecast at lower hierarchical levels then indicated in the Budget Liaison Contact List however you must submit a summary package for the budget unit you are reporting on, as outlined in the Contact Listing. Please see Appendix D for help with combining files.
3. Auto Benefit Calculations: In this template, benefits will automatically be calculated and populated in the appropriate object code line (62306).
Self-funded Compensation Contribution (66012)
For 24/25 units were given self-funded inflation contributions that have been recorded in object 66012. Units are required to identify their plan by FRS category (where possible) in column F of the Sept Forecast tab of the forecast template. If a balance remains in 66012 you are asked to explain this in your summary of financial position explanation on the Summary tab. 
Unit Planning Parameters for 2024/25
· Carryforward spending is not approved, except in special previously approved circumstances.
· Self –funded compensation contributions should be resolved in-year and at the earliest possible opportunity If your unit has a balance in 66012 please identify your plan to address this within your forecast. 
· Given the timing of the September forecast, some employee groups may remain unratified. Please do not include any assumptions around inflation or other compensation/ monetary outcomes for these employee groups.
[bookmark: _Unit_Checklist_for]Unit Checklist for September 2024 Forecast
· Have you submitted a forecast within your approved budget allocation – i.e., No planned carryforward spend?
· Have you identified your plan for the self-funded inflation contribution (if relevant) in your forecast template if not already resolved prior to forecasting?
· Have you completed the Summary of Financial Position that reconciles to your forecast template?
· Have you ensured you did not make compensation or inflation assumptions for unratified employee groups?
· Have you explained Base and OTO budget adjustments that change your net budget position, in the ‘Sep Forecast’ tab notes?
Completed forecasts are to be submitted to the Budget and Financial Planning Office by Monday, September 9, 2024 to budget.innovation@uoguelph.ca 


[bookmark: AppC]Appendix C: Instructions for Forecast Data Download  
Step 1:  Download the ‘September 2024 Forecast Template Package’ found on the IRP website.
Complete One Budget Download:
Step 2: Complete the FRS 2425 Budget Download Tab in the package by downloading your unit’s data on, or as close to, July 31, 2024
1. Login to FRS
2. Go to FRS -> Budget -> Summary -> Object
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3. Select Period - Current Year. Type the Fund & Unit Number that you want to use for the forecast. (You do not need to make any changes in Group Section)
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4. Hit Run Button
5. After the FRS report is run, go to the bottom of the web page. Click Excel
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6. Open FRS downloads
[image: ]
7. Go to the FRS 2425Budget Download Tab in the package and enter the date the FRS data was downloaded in Cell B2 and the unit number and the unit name in Cell B3.
8. Copy & Paste FRS Downloads to this tab, starting from Cell A8 excluding headers from the FRS Download.
9. The Budget section in the Forecast tab will be populated automatically
10. Check the boxes in columns D and E. If they are green (or have a zero balance), it means the Forecast Template matches with the FRS download. If the boxes are red (contain a value greater than zero), it means FRS does not match with this forecast template and reconciliation is needed. To help determine where to reconcile please look at column I and if an object code is missing in the template, it will be highlighted in red in this column. If this happens, please send the template to your budget liaison and they will add the missing object codes and send the updated template back to you. Note: if you are using the combined file, that is used to merge multiple forecast files into one, please ensure each forecast file has the same object codes, otherwise object codes will be missed in your combined file.
Complete the three Actual Downloads:
Step 3: Complete the 2425 FRS Actual Download Tabs in the template
1. Go to FRS -> Actual -> Summary -> Object
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2. Select Period – 2024-07. Type the Fund & Unit Number that you want to use for the forecast. (You do not need to make any changes in Group Section)
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3. Hit Run Button
4. After the FRS report is run, go to the bottom of the web page. Click Excel
[image: Chart

Description automatically generated]
5. Open FRS downloads
6. Go to the FRS 2425 Actual Download Tab in the package.
7. Copy & Paste FRS Downloads to this tab, starting from Cell A8 excluding headers from the FRS Download.
8. The columns of YTD Spend and Commitments in Forecast tab will be populated automatically
9. Check the box in columns E. If it is green (or has a zero balance), it means Forecast Template matches with the FRS download. If the box is red (if value is greater than zero), it means FRS does not match with this forecast template and reconciliation is needed. To help determine where to reconcile please look at column I and if an object code is missing in the template, it will be highlighted in red in this column. If this happens, please send the template to your budget liaison and they will add the missing object codes and send the updated template back to you. Note: if you are using the combined file, that is used to merge multiple forecast files into one, please ensure each forecast file has the same object codes, otherwise object codes will be missed in your combined file.
Step 4: Complete the following step for 2122-2324 FRS Actual Download Tabs in the template
1. Go to FRS -> Actual -> Summary -> Matrix
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2. Select Month Range - 2021-05 to 2024-04 and set the column header to Fiscal Year to populate the FRS 2122-2324 Actual Download tab. Type the Fund & Unit Number that you want to use for the forecast. (You do not need to make any changes in Group Section)
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3. Hit Run Button
4. After the FRS report is run, go to the bottom of the web page. Click Excel
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5. Open FRS downloads
6. Go to the FRS 2122-2324 Actual Download Tab in the package.
7. Copy FRS Downloads starting at Cell A2 & Paste to this tab, starting from Cell A8 excluding headers from the FRS Download.
8. The columns of YTD Spend and Commitments in Forecast tab will be populated automatically
9. Check the box in columns C-E. If they are green (or have a zero balance), it means Forecast Template matches with the FRS download. If a box is red (if value is greater than zero), it means FRS does not match with this forecast template and reconciliation is needed. To help determine where to reconcile please look at column I and if an object code is missing in the template, it will be highlighted in red in this column. If this happens, please send the template to your budget liaison and they will add the missing object codes and send the updated template back to you. Note: if you are using the combined file, that is used to merge multiple forecast files into one, please ensure each forecast file has the same object codes, otherwise object codes will be missed in your combined file
Please complete the instructions above in Appendix C – Instruction for Data Download prior to completing the following Forecast template instructions.
 


[bookmark: AppD]Appendix D: Combine Template Forecast Instructions
The “Forecast Template Combine” file allows users to combine multiple unit forecast templates into one combined template 

This will be done using a built in Excel function called Power Query 

Steps:
1. Close any templates that are open 

2. Data -> Get Data -> From File -> From Folder

[image: ]
3. In the popup, open the folder where the templates are located and click open
Note: Folder must contain nothing other than the files to be combined

[image: ]

4. Click drop down button for Combine and select “Combine & Load”
Note: Make sure all templates to be combined are displayed on the popup 
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5. Select Sep Forecast under Parameter and click ok
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6. In the new sheet that is created, close "Queries & Connection" on the right side
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7. In the Forecast sheet, enter the name of the sheet that was created into cell C6 (highlighted in yellow), this tells the Forecast sheet where to pull the data from
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8. Check to see if data is pulled correctly 

Notes:
1. Refreshing Data
If you make any changes to any of the templates that has been compiled, you can simply refresh the data by Data -> Refresh All
Note: Must have all templates closed
[image: ]
2. Comments
Comments will not be combined. Units can add comments in Column V as necessary. 



[bookmark: AppE]Appendix E: Vacancy Savings Template 
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Framework:
Please follow guidelines below for downloading data and filling out the framework. 
Step 1: Find all the vacant positions
- Please login to FRS. Budget -> Position -> Unit
- Select 'Current Year'.
- Optional: Please type the department number or unit number you are forecasting under Unit
- Optional: Enter object code by employee groups. Please refer to the Salary Forecast tab in the template to find the object code for each group
- In search field, type in 'Vacant' & click 'Run' to run the report
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- FRS will run a list of the vacant positions. It includes position numbers, payroll distributions and funding & % Distribution within this department.
Below is an example of the FRS Budget Position Report
  * if a position is funded from different departments, only the % funded within the selected department/unit will show in this report.
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Step 2: Fill the Vacancy Savings Template
- Please fill in the information for each vacant position into the template based on the FRS report
- Copy Position data into Column A starting at Row 6
- Copy Job Title data into Column B starting at Row 6
- Copy Salary data (column K) into Column I starting at Row 6
- Fill in Column C, E to H, and O to Q
Step 3: If applicable, below is the instruction to find the working period for 7-8-9 months continuing full-time positions in FRS.
- Go to the Budget Position Report in FRS and click Tran in the Position Line
[image: ]
- FRS will direct to a new web page and the working period could be found under Funding Date Range.
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Please note: the total funding in FRS report for 7-8-9 months continuing FT positions are pro-rated amount for the working period, not annual salary.
[bookmark: AppF]										
Appendix F: Summary of Financial Position 
This year, units are required to comment on their summary of financial position included in the ‘Summary’ tab of the Forecast template.

This summary is prepared utilizing information from the September Forecast tab. Units are asked to provide a summary of their unit’s in-year financial position to help explain forecasted changes.

If your anticipated year-end position is greater than $100,000 or 2% of your overall budget (excluding carryforward), please provide a brief, high level explanation of your forecasted in-year position by identifying major variances. Please indicate this in the box provided on the ‘Summary’ tab.
 
eg - Through efforts to increase revenue and reduce cost, dept x expects a year-end surplus of $400K due to: RFT personnel savings of approximately $800K, textbook sales growth of $200K, and extraordinary equipment expenditures of $600K to replace end of life machinery.
 
Column variance analysis/explanations:
 
If there are material variances across categories that have not been explained in your Summary of Financial Position explanation, please include details in column I to explain these variances. Explanations should reconcile to your forecasted position.
 
Compensation Contribution 66012 balance:
 
If you are able, please articulate your plan to address your units balance in 66012 in the appropriate FRS object codes on the 'Sep Forecast' tab using Column F. Your budget in column F in the Summary table, therefore, should include adjustments to offset object 66012. If you are not able to articulate this and therefore there is a remaining balance in 66012 in the summary table, please briefly identify your plan to address this. This should including FRS category where possible and timeline for implementation. Please include this in the box provided to explain your summary of financial position. 
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object level or at the type level (grouping level 2), not both. The exception to this is in salaries as each

object code in salaries needs to be forecasted at the object level to get the appropriate benefit rate. If you

have values in both the object and the type level the summation formula at the type level will, by

default, sum the object codes. For example, the below Figure A on the left has a total of 7 at the type

level (grouping level 2 total on Memberships and Training) and is pulling based on information

provided at the object level and ignores the amount provided on the total for Memberships and Training.

In the figure on the right, if you only place data at the type level total and nothing at the object level the

formula will pull in the total of $200 as the Memberships and Training total.
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